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Revised Ohio Child Support Guidelines 

 

Copyright Notice 
 

You may not reproduce, transmit, transcribe, store in a retrieval system or translate into any 
human or computer language this manual and software. These actions, in any form or by 
any means, are illegal without the express written permission of Puritas Springs Software. 

 

Limited Warranty 

 
The record owner of this application may, for a limited time, download the application con-
sistent with his or her license(s) for purposes of re-installation, diagnostics, moving to a dif-
ferent computer by uninstalling it on one computer and installing it on a different one. Al-
though we are currently making every effort to make old, out-dated versions available for a 
considerable length of time, for various reasons, downloads may eventually become un-
available. Availability is at the sole discretion of Puritas Springs Software and Puritas 
Springs Software reserves the right to define and decide issues regarding availability. 
 

Disclaimer & Limitations 
 

Puritas Springs Software provides Revised Ohio Child Support Guidelines, consisting of 
both the software and this manual, "AS IS." The software and manual carry no warranty as 
to performance, merchantability or fitness for any particular use. Puritas Springs Software 
specifically disclaims all warranties, express or implied, regarding the software or our ser-
vices, and Puritas Springs Software does not warrant that the software or services are 
free from defects, interruption, errors or other program limitations. For states that have limi-
tations on implied warranties, any such implied warranties are limited to 60 days from the 
date of purchase. The rights provided by this Limited Warranty shall be limited to the origi-
nal, registered and recorded purchaser of the software. Said rights are limited to the cost of 
the software and are non-transferable.  You assume all liability and responsibility for the ac-
curacy of any form produced by this software. Recognizing this, Puritas Springs Software 
has exercised due care in the preparation of the software and manual. In no event, how-
ever, shall the authors or publisher be liable for direct, incidental or consequential damages, 
or damages of any type, arising from the use of Revised Ohio Child Support Guidelines for 
Windows. 
 
This Agreement, together with the Licensing Agreement you accept during installation, sets 
forth Puritas Springs Software’s entire liability and your exclusive rights and remedy with 
respect to the software. Headings are included for convenience and shall not be considered 
in interpreting this Agreement. This Agreement does not limit any rights that Puritas 
Springs Software may have under trade secret, copyright, patent or other laws, federal or 
state. 
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Revised Ohio Child Support Guidelines—

Version 10 (ROCSG10) comes in versions 

for both Windows and Mac operating sys-

tems. 

 

Windows. Compatible with Windows 10, Windows 8, Windows 7, Windows Vista 

and Windows XP. 

 

Mac. Compatible with OSX Versions 10.8 and higher. Note that the Mac version 

requires Microsoft Word in order to be able to preview and print worksheets. 

 

Downloading 

 

Step 1 – Visit www.puritas-springs.com. Although it may not be your default or 

favorite browser, we recommend Windows users use Internet Explorer to download 

the installation executable. Mac users should fare well using Safari. 

 

Step 2 – Click the Password Search button. On our Home page you'll see a 

Password Search button on the right. Click on the button to display a page con-

taining a search text box and associated button. 

 

Step 3 – Enter Your Password. Place the password that was assigned to you in the 

email you received when you purchased the application in the search text box, and 

click on the Search Password button just below. You may need to contact us for a 

refreshed password. 

 

Step 4 – Click the Download Button. The search will return a link to an entry page 

with a large button labeled Click Here To Download Update. Click the button. 

 

Step 5 – Run the File. Click on the link at the bottom of the page. The link will 

typically say something like: Click here to download the installation setup file. If 

you're using Internet Explorer, at some point a prompt will appear asking whether 

you wish to Run or Save the file. Choose Run and begin installation. Mac users 

will need to go to the Downloads folder, open or mount the dmg file, and double-

click on the Mac installation package file: rocsg10.dmg. 

 

Additional Windows Instructions: Puritas Springs Software is certified as an au-

thentic Windows publisher and therefore installation problems are rare, but depend-

ing on your security software and configuration, you may be asked to verify your 

intention to install ROCSG10. Of course you’ll need to give the necessary permis-

sions. Unfortunately, due to the diversity of security software and personalized con-

figuration options, it is impossible to give you more precise instructions in this re-

gard. It should suffice to say that users rarely have problems with downloading and 

installation, but give us a call if you do. 
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Example. Note that certain security software, including old versions of Internet Ex-

plorer, may not give you the option to Run. You should always be able to run the 

download, but you may need to do a bit of detective work to do so. For example, in 

some instances you may receive the message: setup... is not a commonly 
downloaded program and could harm your computer. In this case you'll need to 

click on Actions before you see a link labeled Run anyway. Click Run anyway. In 

another instance, you still may not get the Run option, in which case you'll typically 

see a More info link (which is easy to miss, so look over any dialogs carefully). 

Click on the More info link and you'll be presented with the option to Run. 

 

Additional Mac Instructions. Mac users will find the downloaded dmg file in their 

Downloads folder. Double-clicking the dmg file will “mount” the disk image. In 

Finder, click the dmg file (in the Devices section depending on your selected View) 

and you’ll see the file’s contents – a pkg file. Double-click the pkg file and Mac ap-

plication installer will take you through the customary installation steps. All newer 

programs/downloads are GateKeeper compliant, so you should not receive any 

download warnings. 
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In General 
 

Install Revised Ohio Child Support Guidelines—

Version 10 (ROCSG) to your hard drive by follow-

ing the steps outlined below. 

 

Network Computers. You must have a network or 

multi-user license to use ROCSG10 on more than 

one computer. We are unable to provide technical support to users that have pur-

chased a single-user license and wish to “network” multiple installations or save files 

to server. 

 

Installation Steps—Windows 
 

A.  Complete the download instructions contained on the previous pages of this man-

ual. 

 

B. The Preparing to Install progress meter will appear until the Welcome dialog 

displays. Click the Next button to proceed with installation. Click Cancel if you 

want to abort installation. 

 

C.  The Puritas Springs Software Licensing Agreement appears in the next dialog. 

Check the radio button labeled I accept the terms in the license agreement 
and continue with the installation by clicking on the Next button. If you do not 

agree to the terms of the Licensing Agreement, you will not be able to continue 

installing the program. 

 

D.  Verify your user identification information and click the Next button. On some 

systems a checkbox will appear: Install this application for:. Select Anyone 
who uses this computer (all users). 

 

E.  Verify the destination folder. We strongly recommend the default: on 64 bit sys-

tems—C:\Program Files (x86)\Puritas\ROCSG10; on 32 bit systems—

C:\Program Files\Puritas\ROCSG10. We do not support installation to alter-

nate locations. Click the Next button to continue. 

 

F. The next dialog asks you to select the location where the database files will be 

stored. Again, even if you have a network version, we strongly recommend the 

default: C:\Puritas\ROCSG10\Files 

 

G. The Setup Complete dialog advises you that the installation process was suc-

cessfully completed. 

 

 

Installing ROCSG10 
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Updating & Reinstallation 

Because laws and relevant data change periodically, ROCSG10 automatically checks 

for updates each time you start it. If you are connected to the Internet and an update is 

available, you will be notified and given the option of choosing to download and in-

stall it at that time. If you select No, ROCSG10 will open as usual and you will re-

ceive the same notification the next time you start the program. If you select Yes, the 

update will begin to download and should see a bar meter that shows you the progress 

of the transmission. When the installation file is completely downloaded, installation 

of the new version will begin and proceed automatically. When the process is com-

plete, you may restart ROCSG10 using any of the methods described in the following 

section. 
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When you start Revised Ohio Child 

Support Guidelines—Version 10, it 

displays a main windows that is di-

vided vertically. The left side is the 

tree view that provides access to all 

the available worksheets, support 

scheduler and preview and printing functions; and a right side that shows the work-

sheet that was selected in the tree view to the left. The Sole Residential/Shared Par-

enting worksheet is displayed by default on when you start ROCSG10. The work-

sheet you see when you start ROCSG10 and when you select the New command pro-

vides access to a blank set of child support worksheets (blank except for any informa-

tion that may be present in the DEFAULT file). The cursor is blinking inside a text 

box that is located in the caption section of the worksheet. The text box will move 

around on the form as you enter information. Use the <TAB> v key to move from 

field to field. 

 

The Video. Don’t overlook the utility of the instructional video that is part of 

ROCSG10. You can view relevant excerpts of the video by using the context or 

popup menu that appears when you right-click your mouse. 

 

Data Source. ROCSG10 has a Data Source command for every overrideable and 

read only field. That means if you want to know how a calculation is being made or 

where certain information is coming from, you may use the Data Source command 

by selecting it from the menu that appears when you right-click your mouse. 

 

TIP. Most users know that you advance from field to field on a form by using the v 

(tab) key; however many do not know that jv can be used to cycle backwards 

through fields. Of course, you can also point to different areas of the form with your 

mouse to jump to remote spots of the form without needing to press v repeatedly. 

 

Step 1. Completing the Sole/Shared Parenting Worksheet. 
 

When you start Revised Ohio Child Support Guidelines the cursor is blinking in the 

Father’s Name field in the caption section of the worksheet. 
 

You can follow along with the data entry process by opening the SAMPLE file that is 

part of the ROCSG10 installation. We’re using the annotated, long form worksheet. 

 In the Father’s Name field type James Sample, then press v 

Entering 
Information 

— 
A Tutorial 
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 In the Mother’s Name field type: Mary Martin and press v. 

 The text box moves to Case No.; type “17 DR 123456” and press v. 

 For the remaining entries, press v after each of the following: 

 Number of Minor Children - “2”. 

 Sole Residential checkboxes - Leave this section of 3 checkboxes 

blank. Press v to get to the Shared Parenting checkbox. 

 Shared Parenting checkbox - Check if it’s not checked already as 

the default. Then press v to get to the Father is obligor checkbox 

and make sure it’s checked. It probably is by default. 

 Tab to line 1a. 

 Father’s annual gross income - 55000. 

 Mother’s annual gross income - 25900. 

With respect to the last two entries, note that you cannot enter dollar signs ($) or com-

mas (,) in currency entries. When you’re finished making these entries, your screen 

should look like the one below. 

Figure 1. Top portion of sample file  

* Note that the annual summary amounts at the top (the black boxes containing red num-
bers), will not agree with what you see because the illustrated file was completed beyond the 
point we’ve completed in this tutorial. Open the Sample.R10 file for additional information. 
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It hardly seems worth going through every entry in the worksheet. The pattern is ob-

vious—make your entry and press v. 

 

Here are some important and handy tips for using ROCSG10: 

 

 TAB & SHIFT TAB. If you’re following through this example, you’ll note we 

told you to use v after each entry. Note also, however, that if you hold the j 

key down when you press v, you can move the focus backwards. 

 Check. If there are any errors in the worksheet, use the Check button (the red 

checkmark) on the tool ribbon at the top of the screen to disclose them. In this 

context, be aware that ROCSG10 will always notify you if you attempt to print a 

support worksheet that has errors in it. 

 Data Source. You can right-click your mouse on all overrideable and read only 

fields to learn how they are completed. This is handy when you’re wondering 

how ROCSG10 automatically completed a particular field. 

 Help. Certain fields have a Help command that is available from the menu that 

appears when you right-click your mouse. The help topics are a valuable re-

source that should not be overlooked. 

 Video. For a more in-depth treatment of the various sections of the worksheet, 

the Video command in the right-click menu provides access to all the various 

YouTube instructional videos. 

 
Step 2. Give the File a Name 
 

Look at the title bar on your display and you’ll notice that you haven’t named the 

file yet (assuming that you haven’t simply opened the Sample.r10 file). You are 

reminded of that fact on the title bar where it says Untitled.r10. Don’t work in your 

file too long without giving it a name. After you enter a few bits of information on 

the worksheet, you’ll want to use the File|Save As command to give your file a 

name. You may use any valid file name, but use the r10 extension, or better yet, 

leave it off and let ROCSG10 add it automatically. Once the file has a name, you’ll 

see it on the window’s title bar. You can see the Sample file name on the title 

bar in Figure 1. Avoid using the File|Save As command once you’ve given 

your file a name. Use the Save button on the button bar to save file changes 

AFTER you’ve used the Save As command to name the file. 

 

Where are My Files? By default your client files are stored at: 

 
C:\Puritas\ROCSG10\Files\. 
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Step 3. Completing the Worksheet. 
 

At this point the worksheet is completed up to line 1a and the file is named. You can 

display the remainder of the worksheet by simply scrolling down. You can scroll or 

tab your way through the rest of the worksheet completing the remaining fields. Re-

member to press v after each entry to record that entry and advance to the next 

field. Occasionally you’ll encounter a boxed area with a button where you can enter 

additional information that supports the calculation of a particular line. If you have a 

question about the dialogs, you can consult the Special Input Considerations topic 

of the help file by clicking on the Help button in the dialog. You can get to the help 

file by clicking the Help on Specific Lines item on the Help menu. 

 

As a further explanation, look at the fields that are contained in the Calc Line 8 Adj 
button. It is the adjustment for minor children born to either parent and another par-

ent which children live with the party parent. This additional information, the fields 

in the dialog, is necessary because line 8 contains the result of a calculation. The 

Line 8 Other Resident Children dialog permits you to enter the raw data without 

performing the mathematics necessary to arrive at the line 8 figure manually. 

 

Any instance where additional information is required, you’ll find dialogs accessible 

via the associated buttons. You’ll find a box for line 11 (local tax adjustment), line 

19 (child care expenses) and a few other places. Each box provides a dialog for you 

to enter collateral information necessary to complete that part of the child support 

calculation. 

 

The process of completing a worksheet doesn’t involve much more than what’s al-

ready been explained. Obviously, you can complete a split parental worksheet by 

clicking on the Split Parental item in the main window’s tree view or on the Dis-
play menu. You can view and enter information on the full length worksheets, but 

you can also do so in the abbreviated (short form) worksheets. 

 

Step 4. Previewing & Printing Forms 
 

You can print any one or combination of forms by selecting Preview/Print on the 

ROCSG10 File menu. There is a hot key combination for printing any worksheet or 

combination of pages: <CTRL><P>. In addition, you can use the Print button on 

the tool ribbon at the top of the screen. 

 

In the Mac version, you must have Microsoft Word installed and all previewing and 

printing is done via Word. In the Windows version, Microsoft Word is recommended 

but not required. Preview via Word permits the following functionality: 

 

 Faxing worksheets 

 Emailing worksheets 

 Spell checking worksheets 

 Interlineating or creating marginals or footnotes on the to-be-printed worksheet 

 Utilize advanced printer functions such as duplex printing, printing non-

contiguous sets of pages, etc. 
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The Support Scheduler is able to provide a more 

detailed computation of the arrearage and interest by 

maintaining an exact accounting of payments due 

and made as well as the accrual of interest. It does 

this by maintaining a transaction-by-transaction ac-

count instead of doing the same thing by formula (as did the old arrearage calcula-

tor). This method makes the Support Scheduler capable of handling much more 

complex support histories because, for one thing, it is not limited by the number of 

support order modifications. 

 

The Worksheet 

 

In General. For offices that use any of our other programs, i.e., the probate or Ohio 

estate tax programs, the Support Scheduler worksheet should look familiar. It 
bears a strong resemblance to a spreadsheet. However, we’ve automated the Sched-
uler so that you can enter child support due in one basic procedure rather than hav-

ing to make hundreds of individual entries to compute an arrearage over a period of 

years. 

 

A component you need to be familiar with is the Navigator bar. The Navigator bar 

is located just below the normal, global tool bar that you probably use for opening 

and saving files. It is at the leftmost edge of the tool bar and looks like a group of 

cassette deck-like buttons. It is used to move around in the grid (in a more limited 

way, ie., to the beginning or end, or up or down one transaction) and it is also used 

to add new entries (using the + button) and delete entries (the - button). 

 

Entering Information. When the Support Scheduler first appears, the 

“spreadsheet” is empty. When you’re entering a transaction (usually a payment due 

or a payment made), you must make an entry in the Date, Support Due, Sup-
port Paid and Rate fields. It is not necessary to make an entry is the Description 

field, although its utility should be obvious. As usual, use the v TAB key to move 

from field to field. 

 

IMPORTANT NOTE. As far as formatting is concerned, when you’re entering an 

interest rate to be used for arrearages, enter the percentage as follows: 10% would be 

entered as “10”.  

 

Saving Transactions. Information you type at the top of the screen is “saved” and 

calculated when you press the v key or you move to a different field by clicking 

the mouse button. When you do “save” an entry, it will jump into chronological or-

der automatically. It is not necessary to enter your transactions in any particular or-

der. 

 

Support Scheduler 
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Adding More Transactions. To add another transaction, you can either click on the 

Navigator bar’s + button, press bA, or use the Add command on the Display 
or right-click pop-up menus. A new blank transaction record is appended to the table 

and is ready to be completed. You needn’t worry about entering transactions in a 

particular order. Remember, when you save your entry, your transaction will auto-

matically jump into chronological order, so don’t be surprised if it jumps off the 

screen to a new location. 

 

Series Buttons 
 

There are many occasions when you’ll want to avoid entering transactions individu-

ally and want to enter a series of transactions all at once. This is not only a giant 

time saver but also reduces the likelihood of making mistakes. We’ve included a few 

paragraphs below explaining the functions of the three utility buttons. 

 

Support Orders. The first is the Support Order button. As you can imagine, if you 

were attempting to compute the amount of child support payments that should have 

been made over a ten-year period, you wouldn’t want to be entering each of the re-

quired 120 payments one by one. The Support Order button permits you to define 

the terms of a support order or modification so that the required number of payments 

will be entered automatically. 

 

To take a simple example, let’s use a support order wherein the obligor must pay 

$200 per month commencing 8/15/89. Obviously, entering each payment due in the 

table would be a time-consuming task. Using the Support Order button, we can 

simply enter six items: a description such as “Support Payment Due Date”; the 

amount - $200.00; starting and ending dates – 8/15/89 and today’s date respectively; 

a frequency of either monthly or weekly payments; and the statutory interest rate – 

10% or 0.10. When you click the Ok button, the table will be populated with the 130 

or so entries that make up the exact number of payments that should have been paid 

over the designated period of time. 

 

Payment Series. The second utility button is the Payment Series button. To con-

tinue with the previous example, let’s assume the obligor made regular monthly pay-

ments starting 8/15/89 but stopped on 7/4/96. Rather than entering each payment 

individually, we could use the Payment Series button to enter essentially the same 

information that is required via the Support Order button. The only difference is 

that we would not typically enter an interest rate and, contrary to what we said 

earlier, the amount of the child support payment is entered as a positive num-

ber when using the Payment Series utility. 

 

Clear Table. The third and last utility button is the Clear Schedule button. It does 

what its name implies. When you press/click it, it clears the schedule. Be careful 

here, there’s no undo. 
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Interest Threshold 

 

The Interest Threshold command can be found on the Options menu. The purpose 

of this command is to set a threshold below which interest amounts will not be 

added to the Interest column of the schedule. A good example would be a situation 

in which a support order calls for payments to be made on the first of every month, 

but perhaps, for employer payroll reasons, the payment is not made until the first 

Friday of every month and therefore most payments are a few days to a week late. If 

no threshold were set for the computation of interest, the table would calculate a few 

pennies of interest due on every payment. In order to make the computation more 

realistic and avoid working with insignificant amounts of interest, you can set a 

threshold below which interest will not be added. The default is $1.00. 
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This paper manual is merely an outline of the basics of installation, getting started 

and data entry. From there, you can get help via the program’s Help|Table of Con-
tents menu. This program has context-sensitive help. That means that you get help on 

a specific topic without searching for that topic. It’s worth commenting that 

ROCSG10 has the best help files of any application we’re familiar with. 

 

For example, every dialog (ie., the line 8 dialog) has a help button. Clicking on the 

help button brings up an associated help topic that should clear up any questions you 

have about the entries you would make in that dialog. Menu items have context sensi-

tive help too. You can access help on menu items by navigating to the menu item in 

question using the keyboard and, while the subject menu item is highlighted, pressing 

your l key. Another useful feature of ROCSG10 is that when an error message 

or warning is displayed, in many instances the notice has a Help button that will 

take you to a related help topic explaining the error or warning. 

 

If you’re like us, you might be doubtful as to whether help files can be truly helpful. 

Regardless of  any drawbacks, we found them to have significant benefits over their 

paper counterpart. 

 

Help Is Always There 

When we were at the office, the manual was at home. When were on the computer at 

home, the manual was at the office. On unfortunate occasions, that alone can make 

you lose a day. It never happens with help files. They’re always there. A copy for 

your home computer, and a separate one for the office. Ditto for your laptop! When 

you’re desperate for information, you can always count on its accessibility. 

 

Help Is Hyperlinked, Searchable & Better Indexed. 

We took extra time to develop a logical system of indexing. You should find that a 

help file’s searchability can be a time-saver when you’re looking for a snatch of text. 

The point and click links between key words provide instant information without 

fumbling though page after page looking for something. This non-linear characteris-

tic is part of what makes help files so uniquely useful. 

 

Help Is Up To Date 

Because they are printed in larger quantities, paper manuals fall out of synch with last

-minute or late-minor programming changes during the duration of the “printing.” 

Help files, on the other hand, are easier to keep current with programming changes 

because their modification involves no additional processing steps to implement (i.e., 

physical transportation, printing, binding, etc.). 

 

Paper Fix 

Don’t forget that any help topic can be printed simply by pressing the help window’s 

Print button, or using the menu’s Print Topic command. 
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Checking out the following help topics before working with 

ROCSG10 will help reduce the learning curve, although you 

should find ROCSG10 relatively straightforward to use. 

 

1. Support Scheduler 
The Scheduler does a lot more than compute the interest on 

arrearages. It compiles a complete record of payments due 

and made. In other words, you can keep and print a complete 

transcript of an obligor’s account. Yes, it still can calculate 

interest on arrearages giving you more options than ever before. 

 

2. What is the DEFAULT.R10 file? 
This topic explains how to customize the blank, start-up worksheet so that common, 

usually unchanging information is set up to appear automatically when you select 

New from the File menu. 

 

3. Using The Keyboard 
This is a good topic to print because it summarizes all the key commands that are 

available in the program. 

 

4. Child Care Expenses 
This may be the most controversial area of the worksheets. You can read all sides of 

the issue in this help topic. 

 

5. Special Input Considerations 
A table of contents for all the gray box areas of the worksheets that require or benefit 

by additional instructions. 

 

6. Income Annualizer 
The potential is there to use this section of the worksheet every time you do a calcula-

tion, so you'll want to be acquainted with the annualizer's strengths and weaknesses. 

 

7. Shared Parenting Dialog 
This topic explains one of the biggest changes in ROCSG10 . As shared parenting 

orders become more and more the norm, you'll definitely want to review this topic. 

You'll find this section of the form at Line 24b. Also note that the shared parenting 

help topic contains much useful information. 

 

8. Minimum Orders 
Eventually you'll get an error message related to minimum orders and may wonder 

what it's all about. This topic explains it. 

 


